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Introduction

About the Program
The Adverse Drug Interactions Program searches for interactions between
two and up to 50 drugs. It allows you to list each of the drugs your patient is
taking and then view the possible interactions on the screen as well as view
reference citations pertinent to the interaction. The user-friendly program
provides menus and toolbar buttons for easy guidance.

Keyboard Access
The new Adverse Drug Interactions Program provides keyboard access for
flexibility and ease of program use.  By simultaneously pressing specific
keys (commonly called shortcut keys) you can quickly accomplish most
program tasks.  See Keyboard Shortcuts on page 35 for a complete list of
these shortcuts.

Patient Feature
The new Adverse Drug Interactions Program features the ability to save
drug lists under a patient’s name. Information about the patient may be
saved in a patient profile and included in the Interactions Report. (Drug lists
may also be saved as .pdl files as before.) See Managing Patients on page
31 for more details.

Compatibility with earlier versions
This new program version makes the transition from old versions to new as
easy as possible. Users of Adverse Drug Interactions Program for Windows
can open earlier program patient drug lists and use them in the new
program. The default folder in the Windows 3.1 version was /dipwin.

The old Windows 3.1 patient drug list files (.pdl file) may be opened within
the new program.  However, once the file is saved in the new program, it
may no longer be used with the old Win3.1 version.

Criteria for listing interactions
These listings are mainly based on clinical reports, but theoretical (based on
mechanisms) interactions listed as contraindications in package inserts are
also included.  New adverse interactions are continually being reported; the
absence of a listing does not necessarily mean that drugs will not interact
when given concurrently.  Interactions extrapolated from animal studies or
from interactions reported with related drugs may not be included here.
Drugs with no interactions are listed with an asterisk (*) when searching for
interactions.
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Interactions between general anesthetics and drugs likely to be
administered during surgery, such as autonomic drugs and local
anesthetics, are not included.  Interactions useful in therapy, such as the
increased plasma concentration of penicillin with concurrent use of
probenecid, or the interaction of a poison with its antidote, are also not
listed.  Drug combinations should generally be looked up under their
components.

Common additive effects, such as occur with use of two antihypertensive
agents, two central-nervous-system depressants, or two drugs that affect
blood clotting, are generally not listed.  Many drugs prolong the QT interval
slightly (www.qtdrugs.org); the risk of an arrhythmia when 2 of them are
taken together is generally small in patients without risk factors such as
advanced heart disease or baseline QT prolongation.  QT-interval
interactions, like other interactions, are generally listed here only when they
have been reported clinically or are listed as contraindications in package
inserts.  Effects expected from the mechanism of a drug’s action, such as
that of potassium on digitalis glycosides or calcium on calcium-entry
blockers, are also not included.  Most interactions of drugs with foods,
beverages or other nutrients are not listed, but foods interacting with
monoamine oxidase inhibitors can be viewed with View | Food – MAOI
chart.

Installing the Program

System Requirements
To ensure proper performance of the program the following
requirements must be met:

• IBM or compatible 486 (or faster) processor

• Windows 95/98/Me/NT4.0/2000/XP

• 12 MB free RAM space

• 5 MB of free disk space

Installation
Installation of the program is accomplished using a setup program
on the program CD.  Insert the CD into your CD-ROM drive.  If
Autoplay is enabled on your computer, the setup will start
automatically in a few seconds.  Alternatively, you may click Start |
Run and browse to your CD drive.  Open the setup.exe file and
click OK.  The setup program will step you through the installation.
Make sure you read the instructions on setup windows then take
the necessary action.
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Start the Program
You can start the program in a number of ways:

• Double-click the program desktop icon. (  )

• Right-click the desktop program icon and select Open

• Click Start | Program | Adverse Drug Interactions Program from
the Start menu.

The program opens the Main Window with the cursor in the Select
a Drug Type or Name text box, ready for you to begin creating a
drug list.

Exit the Program
You can exit the program in a number of ways:

• Select File | Exit on the Main Window menu bar.

• Press shortcut keys Alt+F4.

• Click the “X” button in the upper right corner of the program
window.

Quick Start

Create a Drug List
The first step in using the program is to select drug names from the
left drug list and add them to the List of Drugs to Check on the
right.  There are a few ways to do this:

1. Click the Adverse Drug Interactions desktop icon to launch the
program.  This opens the Main Window shown on page 9.

2. Type the name in the text box, then click the Add button or
press the Enter key;

3. Or, select the name from the scrolling drug list underneath the
text box. Then, either click the Add button or double-click the
name in the list;

4. Or, begin to type the name of the drug. When you see that the
program has automatically selected the drug you are looking
for in the scrolling drug list, press the Shift+Enter keys.
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Viewing the Interactions Report
After selecting all the drugs that need checking, check for
interactions.

1. Click the RUN button.

2. This opens the interactions Report Window shown on page
12).  This report will contain the interactions for your drug list.

This window is editable, printable, and can be saved as a Text
Only or Rich Text Format file.

If there were no detected interactions for your drug list the
statement "No documented interactions were found" will be
displayed in the Interactions Report.  See Criteria for listing
interactions on page 5.

Viewing Interactions for One Drug
The program makes viewing all the interactions for one drug easy.

1. To do this, enter only one drug and click the RUN button. A
Split Viewer Window as shown on page 14 is opened with the
pairs of interactions on the left and the corresponding text on
the right.

2. Select which interaction pair to view by clicking a pair in the left
scroll list.  You can also step through the list using the green
arrow toolbar buttons or the arrow keys on your keyboard.

Viewing the Full Interactions Chart
It is possible to read through, interaction by interaction, the entire
interactions chart contained within the Adverse Drug Interactions
Program.   To do this, select View | Interactions Chart on the menu
bar.

Drug pairs are listed only once in alphabetical order.
For example, Acetaminophen interacting with
Benzodiazepines is listed only in the group with
Acetaminophen.  You won't find Acetaminophen +
Benzodiazepines listed where Benzodiazepines is first,
because the pair was already listed.



9

Getting Acquainted with the Program

Program Windows
The program has three windows: the Main Window, the Report
Window and the Split Viewer Window.  The following paragraphs
provide an example window, identify its elements, and describe its
purpose.

Main Window

As its name implies, the Main Window is the primary program
window.  It is displayed when the program is started and running.
From this window you will run the program, create drug lists, run
interaction reports, manage reports and patients.  A description of
each window element is provided below.

Main Window Element Descriptions

Pulldown
menus

The pulldown menus define all the actions of
the program and provide an organized and
easy way for you to select those actions.
See Pulldown Menus on page 17 for details.



10

Main Window Element Descriptions

Toolbar
buttons

The toolbar buttons replicate the most
common pulldown menu commands.  See
Toolbar Buttons on page 23 for more details.

Text box Upon program startup, the cursor is in the
Type or Select Drug Name text box.  The
drug name must be entered in this box.  You
may type it into the box or you may select a
drug from the list below to enter the drug
name into the text box.

Partially typing a drug name causes the list box
(with option Auto Scroll List Box on) to find the
name you are typing. Once the list box is
highlighting the drug you want, simply click the
drug name or press Shift+Enter and the drug will
be added to the List of Drugs to Check.

Drug name
list

The drug name list is a scrolling list box on
the left side of the Main Window.  Clicking a
drug name in that list will put that drug name
in the Type or Select Drug Name text box.
Double clicking a drug name will add that
drug name to the List of Drugs to Check.

Status bar The status bar is a horizontal strip, at the
bottom of the window that is divided into two
segments.  If the List of Drugs to Check
contains a list that has been named and
saved, the left segment will show the name
of that file.  If the list has been opened as a
defined patient, the name of that patient will
be in the left segment.  The right segment will
show the date that the list was last saved.

You will see a ' * ' character in the left
segment at times.  This indicates that a drug
list has been changed but not saved.  If a ' * '
is alone in the left segment, that indicates
that you have started a list, but have not
named and saved it.
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Main Window Element Descriptions

A ' * ' character appended to the end of a .pdl
file or patient name indicates that you have
made changes to the list and have not yet
saved those changes to that .pdl file or to the
patient's name.

Include
Reference
Citations
check box

You have the option of having reference
citations included in Interactions Reports.
Selecting this box will include references.

Clear List
button

Clicking this button will clear the drugs from
the list.  By default, clicking the button will
issue a warning message to verify that you
really want to clear the list.  To disable this
warning go to View | Options | General and
clear the checkbox for Disable Clear List
Warning.

List of Drugs
to Check

This is the list of drugs that will be checked
for interactions.  Up to 50 drugs may be
entered.  Drugs are added to this list either
by typing the drug name in the text box or by
clicking the drug name in the scrolling list
then clicking the Add button.  You can also
double click a drug to add it to the list.
Remove drugs from the list using the
Remove button or the Clear List button.

Main
program
buttons

Add - Once a drug name is entered into the
Type or Select Drug Name text box, clicking
the Add button will add the name of that drug
into the List of Drugs to Check. The program
will check to make sure that the drug name
exists in The Medical Letter database of
drugs and warns if it is not found there.  Up
to 50 drug names may be added to the list.
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Main Window Element Descriptions

Remove - If a drug name has been added to
the List of Drugs to Check and you want to
delete it from the list, click the drug name to
select it, and then click the Remove button.
To remove all the drug names from the List
of Drugs to Check, click the Clear List button
underneath the box.

RUN - Once you have added all the drugs to
the List of Drugs to Check, click the RUN
button to see the interactions between the
drugs in the list.

Report Window

The Report Window is opened when the RUN button is clicked and
when more than one drug is in the List of Drugs to Check.  Using
the elements (i.e., pulldown menu, toolbar buttons, etc.) of this
window you can view and edit the report.  Also, you can save the
report using any desired name.  A description of each Report
Window element is provided in the table on the next page.



13

Report
Window Element Descriptions

Pulldown
menus

The menus define all the actions of the
program and provide an organized and easy
way for you to select those actions.  See
Pulldown Menus on page 17 for details.

Toolbar
buttons

The Toolbar buttons replicate the most
common actions of items in the pulldown
menus of each window.  See Toolbar Buttons
on page 23 for details.

Report text The report text area contains the result of the
search for interactions between drugs.  To
include a list of reference citations with the
interactions, select the Include Reference
Citations check box before clicking RUN.

Customizing your report – You can customize
the look of your report and change the fonts that
are used for the various items in the report. The
menu selection View | Options | Fonts will get you
to the correct dialog to make changes.  See page
16 for information on customizing the report.

Status bar The Status bar is a horizontal strip (or bar) at
the bottom of the window.  If the current
Interactions Report has not been saved as a
file, then the name of the .pdl (Patient Drug
List) file will be in the status bar. If you are
working under a defined patient, the name of
that patient will be in the Status Bar.  If the
report generated was not from a saved .pdl,
then you'll see a  ' * ' character in the Status
Bar.  If the interaction report has been saved
as a .txt file or an .rtf, then the name that it was
saved to will be in the Status Bar.
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Split Viewer Window

This window allows you to view all the interactions for one drug.
This is presented with the list of pairs on the left and the
interactions report to the right.  Selecting View | Full Report or
clicking the Full Report button combines all the reports for each pair
into one report.  Using the pulldown menu, toolbar buttons, etc. of
this window you can view the report and save it using any desired
name.

Split Viewer Window Element Descriptions

Pulldown menus The pulldown menus define all the
actions of the program and provide an
organized and easy way for you to
select those actions.  See Pulldown
Menus on page 17 for details.

Toolbar buttons The Toolbar buttons replicate the most
common actions of items in the
pulldown menus at top of each window.
See Toolbar Buttons on page 23 for
additional information.
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Split Viewer Window Element Descriptions

Interactions Pairs
List

The Interactions Pairs List is the list of
drug pairs.  Highlighting a drug pair
shows the relevant interaction data in
the Report Text window.  A drug pair
can be highlighted by: scrolling through
the list using the up and down arrow
toolbar buttons, the up and down arrow
keys on your keyboard or mouse click a
drug pair.

Report Text This area of the window contains the
interaction data for the pair of drugs
that is highlighted.  The text is in a
scrollable window. If you want a list of
reference citations with the interactions,
check the Include Reference Citations
check box on the Main Window first.
Also, the menu selection View | Options
| General will bring you to a similar
check box that will do the same thing.

You can customize the look of your
report and change the fonts that are
used for the various items in the report.
The menu selection View | Options |
Fonts will get you to the correct dialog
to make changes.

Full Report button This button is visible only when the Split
Viewer Window has been opened to
view interactions for a single drug.
Before the button is clicked, only data
for a single pair is shown in the report
text window.  Clicking the Full Report
button will merge all the data for all the
drug pairs in the Interactions Pairs List
into one report.
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Changing Program Options
Various features of the program can be changed using View |
Options | General on the menu bar.  Selecting a feature opens a
dialog that allows you to set program options.

General Options Description

Show Toolbar
buttons

Selecting this check box will show toolbars
on the Main, Report, and Split Viewer
Windows.

Auto scroll
drug selection
list

Selecting this check box allows the program
to automatically scroll to the drug name
closest in alphabetical order to the
characters you have typed.

Disable Clear
List Warning

Selecting this box disables this prompt.
Thereafter, when you click the Clear List
button on the Main Window you will not be
prompted if you want to clear the list.

Include
Reference
Citations

If you select this check box the reference
citations will be included in your Interactions
Reports.

Include Patient
Notes

Select this check box to include patient
notes in your interactions reports.

Changing Font Options
The program and the Interactions Reports appearance can be
customized using View | Options | Fonts on the menu bar.  When
selecting this a dialog opens that allows you to set font options.
Keep in mind that you must click the Apply button for changes to
take effect.

Font Options Selection Description

Main
Window

Right and
Left Drug
Lists

Click the Change button next to
this option to change the font
characteristics of the Drug Name
List and the List of Drugs to
Check.
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Font Options Selection Description

Report
Window

Normal
Heading
Drug Names
Alerts
Titles

Click the Change button next to
an option to change the font
characteristics for the report
category.

Split Viewer
Window

Interaction
Pairs List

Click Change next to this option
to change the font characteristics
for the Interaction Pairs List.

Reset to
Default
Fonts

Click Click this button to return to the
settings that existed when the
program was installed.

Pulldown Menus
Pulldown menus define all the actions of the Adverse Drug
Interactions Program and provide an organized and easy way for
you to select those actions.  There are five menus: File, Edit, View,
Patient, and Help. To access the menu items, simply click the
menu category word.  The menu for that category will be displayed
(pulled down).  Next, click one of the action words (commands).

Sometimes a command will be dimmed which means
you will not be able to select the action if it is not
relevant to the window that is currently active.

File Menu

Some File menu commands although the same do different things
for the Main and the Report Window.  The Split Viewer Window
commands (where relevant and not dimmed) are the same as the
Report Window.

File Commands Description

New Clears the List of Drugs to Check.  You will be
prompted to save any unsaved drug lists.

Open Displays the Open dialog for loading an
existing drug list into the List of Drugs to
Check.



18

File Commands Description

Save Main Window - Saves the current drug list
using its current name.

Report Window - Saves the current
interactions report using its current name or a
new name if it had not been saved before.
See Save As for report types.

Save As Main Window - Displays the Save dialog to
save the current drug list as a .pdl file using a
new name.

Report Window - Displays the Save As dialog
to save the report as a Text Only (.txt) file or a
Rich Text Format (.rtf) file.  If a file is saved as
an .rtf, it can be opened by Word and most
other word processing programs and the font
and formatting information will be preserved.
If it is saved as a .txt, the font and formatting
information will be lost.  Text Only files can be
opened by word processing applications or
Notepad.

Delete Displays the Delete dialog to delete a selected
drug list or selected interactions report.

Recently
Accessed Files

Displays a list of recently saved files.  Clicking
the file name will reopen the file.

Print
(Report
Window or
Split Viewer
Window)

Displays the Print dialog so you can print the
current report.  You can select from a limited
number of options and properties in the dialog.
After clicking OK, your print job will be sent to
your selected printer.

You may also click the printer icon on the
toolbar to initiate the printing of a report or
right-click your mouse while pointing to the
report text. This will open a pop-up menu.
Select Print from that menu and you will
initiate printing of your report.
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File Commands Description

Exit Main Window - Quit program.

Report Window - Close the Report Window
and return to the Main Window.

Edit Menu
Use the Edit menu for working with text in either the Report or the
Split Viewer Window.  The Edit menu supports Undo, Redo, Cut,
Copy, Paste, Select All, and Find.

Edit
Commands

Description

Undo This is a multi-step undo.  Actions can be
undone up to the last save.

Redo Reverses the effects of your most recent Undo.
Redo has an effect only immediately after an
Undo command.

Cut Removes the text you highlight from the report
and places it in the Clipboard.

Copy Places a copy of the text you highlight in the
interactions report in the Clipboard, leaving the
selection in place.

Paste Inserts the text copied to the Clipboard using
either the Cut or Copy button.

Select All Selects all the text in the text window.

Find (on this
page)

Opens the Find dialog to allow searching for a
word or text string in the report See Search a
Report on page 29 for details.
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View Menu

Use this menu to view the full Interactions chart, Food – MAOI
chart, P-450 Enzymes chart, and all interactions with a single drug.

View Commands Description

Interactions
chart

Opens the Split Window Viewer to display
all of the interactions contained within the
program's database.

Food – MAOI
chart

Displays a report listing the foods
interacting with MAO Inhibitors.

P-450
Enzymes chart

Displays a table showing important
relationships between drugs and
cytochrome P-450 (CYP) enzymes.

Single Drug
Interactions

Displays a report for all interactions with a
single drug.

Add One Drug This command will check one drug
independently against the existing drug list
without adding the drug to the list.  The drug
will be checked for interactions one-by-one
against each drug in the list.  See Add One
Drug to the Interactions Report on page 28
for details.

Full Report
(Split Viewer
window only)

The Split Viewer window is opened for
viewing all the interactions for one drug.
Drug pairs are listed on the left with the
interactions report to the right.  Usually, one
report representing the selected pair on the
left is visible.  Selecting View | Full Report
or clicking the Full Report button will
combine all the reports for each drug pair
into one report.

Add Drug
(Report
Window only)

After the Add One Drug command has run it
becomes active but states “Add xxxx”
where “xxxx” is the name of the single drug
you added.  After reviewing the report, you
can select “View | Add xxxx” to add that
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View Commands Description

drug to your existing drug list.  Also, there is
a button visible on the Interactions Report
Window that will do the same thing.

Options This command opens the Options dialog
that has two panes: General and Fonts.
These panes list program options you can
set to customize your program.  See
Changing Program Options on page 16 for
details.

Patient Menu

A valuable feature of the program is the ability to create a profile for
each of your patients and to save the drugs they are taking or might
take as part of that profile.  Then, in the future, the Interactions
Report for that patient can be re-run at anytime.  Managing patient
profiles is done using the commands on the Patient menu.

Patient Commands Description

Find Patient Opens a panel to allow selection of a
defined patient.  You may either select
the name from the alphabetized list or
type in the last name of the patient to find
the name in the list.  Selecting a name
will load the associated drug list into the
List of Drugs to Check.  See Find a
Patient on page 32 for more information.

New Patient Opens a panel for defining a patient and
for entering the patient information.  It
has text boxes for First Name and Last
Name.  These entries are required.

There is a Record ID text field so that
you can use whatever identifying number
you want to associate with a patient. This
is optional.
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Patient Commands Description

There is also an area for you to type in
notes.  The “Include notes…” check box
allows you the option of having the notes
included in the interactions report. This is
also optional.  See Add a Patient on
page 31 for more information.

Save Patient Allows you to save the drug list you
created under a patient profile using a
patient name.  See Save a Patient (drug
list) on page 32 for more information.

Save As Patient This command opens a dialog that
allows you to save the drug list you have
opened for another patient or created
without a patient profile to a new patient
name or as any existing patient. See
Save As Patient on page 33 for details.

Delete Patient Opens a panel to allow selection of a
patient.  Selecting a name will delete the
patient from the program.  See Delete a
Patient on page 31 for details.

Edit Patient Info Opens a panel that will allow you to
select a patient name from a list of
program patients.   Clicking the Edit
button will open the Patient Profile dialog
and allow you to change any of the
information fields.  See Edit Patient Info
on page 32 for details.

Recently opened
patient lists

This area of the pulldown displays the
most recently opened patient lists.  You
can open a patient list by clicking the
patient name.
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Help Menu

Use the Help menu commands to not only open the help files but
also to get important information about drug interactions and
contacting The Medical Letter.

Help Commands Description

Contents and
Index

Opens the typical Windows help panel.
Options are given to search the index using
a keyword or to browse through the
contents of the help files.

Clinical
Background

Opens a help window that provides
information about the program and
information that specifies the criteria for
listing interactions, the mechanisms of
interactions, and recommendations.

Getting Started Opens a help window that provides
instructions for creating a list of drugs to
check for interactions and creating the
Interactions Report.

The Medical
Letter Home
Page

Opens the browser on your machine and
connects you to The Medical Letter home
page on the internet.  This action requires
the ability to automatically make an internet
connection.

About Gives information about the current version
of the program as well as contact
information for The Medical Letter.

Toolbar Buttons
The Toolbar buttons replicate the most common actions of items in
the pulldown menus. The buttons will appear raised when the
mouse cursor is moved over it, and the button action is displayed.
A dimmed button indicates that the action associated with it is not
relevant at the moment and nothing will happen if it is clicked.  For
example, examine the Main Window toolbar on the next page: the
button representing “Save patient list” is dimmed.  For the Main
Window, unless you have defined a patient and are working in the
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patient mode, this button is irrelevant and dimmed--any save would
need to be done as a regular .pdl file using the Save file button.
Similarly, when working with a defined Patient, the Save file button
will be dimmed and disabled.

Main Window Toolbar Buttons

Toolbar buttons are visible on the Main Window by
default.  To remove them, select View | Options |
General and clear the applicable check box.  See
Changing Program Options page 16 for more
information.

Report Window Toolbar Buttons

The Report Window Toolbar buttons are replicated in the pulldown
menus except for the Return to Main Window button.  Click this
button to bring the Main Window to the front leaving the Report
Window open.
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Managing Lists of Drugs to Check

Overview
Drug Lists are used to create interactions reports.  These lists can
be saved to a .pdl file or saved as a Patient name for easier recall.

Create Drug Lists
The first step in using the program is to select drug names from the
drug list on the left side of the Main Window and to add one or
more drugs to the List of Drugs to Check on the right.  There are a
few ways to do this:

• Type the name in the Type or Select Drug Name text box and
click Add or press Enter.

• Select (highlight) the drug name in the list of drugs and click
Add or press Enter.

• Double-click the drug name.

• Begin to type in the name of the drug. When you see that the
program has automatically selected the drug you are looking for
in the scrolling drug list, press Shift+Enter.

• Once a drug list has been created you can save it as a .pdl file
or save it using a patient’s name.  See Save a Drug List below
for details.

Remove a Drug From the List
If you want to remove a drug(s) from the List of Drugs to Check:

• Select the drug (highlight it) then click the Remove button.

• To clear the list of all drugs, simply click the Clear List button.

Save a Drug List
A drug list can be saved in one of two ways: as a patient drug list
(.pdl file) with a name you would you like to use, or as a specific
patient name.

Save Drug List as a .pdl File

Saving the drug list using the patient’s drug list (.pdl) file allows you
to maintain lists of drug interactions that are not unique to a patient.
Save the list in one of the following ways:
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• If this is a new list, Select File | Save As on the menu bar, type
the desired name and click the Save button.

• If this is an existing .pdl that you opened, Select File | Save on
the menu bar, Ctrl+S on the keyboard, or right-click the list and
select Save to save it using the same file name.

Save Drug List to a Patient

Saving a drug list to a patient allows you to maintain the list of all
drugs a patient is using to their name.  This eliminates possible
confusion regarding what a patient is taking and interactions that
can result.  Save the list by selecting Patient | Save As on the
menu bar.  The program displays the Save As Patient dialog.  On
this dialog you can save the list to either a New or an Existing
patient.  Once the list is saved to a patient’s name you can then
open the list to rerun the Interactions Report using the patient’s
name and the Find Patient command.

Managing Drug Interaction Reports

Overview
The principal purpose of the program is to create an Adverse Drug
Interactions report.  The program generates interaction reports by
comparing the drugs you listed to the program’s interactions
database.  This section describes how to view, edit, search, print
and save reports.

View Drug Interactions
To view adverse drug interactions reports:

1. Select and add the drug(s) that you want to view interactions
for to the List of Drugs to Check.  See Create Drug Lists on
page 25.

2. Run the Interactions Report for the selected drug(s) using one
of the following ways:

• Click the RUN button.

• Press Enter when the text box is empty.

• To view interactions for a single drug, only add one drug to
the List of Drugs to Check; then select View | Single Drug
Interactions on the menu bar, or click RUN or press Enter.
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Include Reference Citations

If you want to include Reference Citations select the Include
Reference Citations check box before running the report.

You can also include reference citations in Interactions
Reports.  Select View | Options and select the Include
Reference Citations check box on the General tab
pane.

Include Patient Notes

Patient Notes can be created when a new patient is added.  These
notes can be included in the Interactions Reports in one of two
ways:

• Select the “Include notes in interactions reports” check box on
the New Patient or Edit Patient panels.  See pages 21 and 32
respectively for more information.  This will add notes for this
patient only.

• Select View | Options | General, then the Include Patient Notes
check box.  This sets the program options to include notes
when running an interaction report for any patient.  Notes will
only be included if they have been created for the patient.

View Interactions for One Drug

The program makes it quite easy to view Interactions of one drug
with other individual drugs.  To do this:

1. Follow the instructions in Create Drug Lists on page 25 and
run the interactions with only one drug in the List of Drugs to
Check.

2. A split screen viewer window is opened with the pairs of
interactions on the left and the Interactions Report for the first
pair of drugs in the list on the right.

• To view other drug pairs highlight the drug pair on the left.
You can also step through the list using the green arrow
toolbar buttons or the arrow keys on your keyboard.  The
interactions on the right will be updated as you select the
different drug pairs.
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• To view all drug pairs click the Full Report button or select
View | Full Report on the menu bar.

Each drug pair is listed only once in alphabetical order.
For instance, if alcohol is the chosen single drug,
Alcohol interacting with Benzodiazepines is listed only
once.  You won't find Benzodiazepines + Alcohol listed.

View Specialty Reports

Interactions chart

Selecting “View | Interactions chart” opens the Split Window Viewer
to so that you can view the full chart of interactions contained in the
program's database. To view other drug pairs, highlight the drug
pair on the left. You can also step or scroll through the list using the
green arrow toolbar buttons or the arrow keys on your keyboard.
The interactions on the right will be updated as you select the
different drug pairs.

Food – MAOI chart

Selecting “View | Food – MAOI chart” displays a report listing the
foods interacting with MAO Inhibitors.

P-450 Enzymes chart

Selecting “View | P-450 Enzymes chart” displays a table showing
important relationships between drugs and cytochrome P-450
(CYP) enzymes.

Add One Drug to the Interactions Report

Once you have created a drug list you may want to determine
interactions that could occur if an additional drug were added to the
established list of drugs to check.  The Add One Drug command
allows you to specify the drug and then rerun the Interactions
Report.  The report will specifically list the new interactions that
would occur.  In this way you can easily see the interactions without
reviewing the entire report or altering the established list of drugs.

To run this command:

1. Make sure that one or more drugs are listed in the List of
Drugs to Check box.
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2. Select View | Add One Drug on the menu bar or the “+” button
on the toolbar.

3. The program opens the Additional Drug Check window.

4. Type the drug name in the Enter Drug to Add box and click OK
or press Enter.

5. The program runs the Interactions Report.  The report
specifically identifies drug interactions for the added drug at
the beginning of the Interactions Report.

Edit a Report
After a report has been run and is displayed in either the Report
Window or the Split Viewer Window the program allows for content
editing.  The typical editing commands of a word processing
application (cut, copy, paste, select all, etc.) are available through
one of the following actions:

• Selecting the Edit pulldown menu.

• Right clicking anywhere in the report window.  Right-click
options are more limited than the pulldown menu.

See the Edit Menu on page 19 for descriptions
of the editing options.

Change the Report Appearance
The program provides default fonts, font color, and size.  You can
change these defaults using the View | Option commands.  The
options you select will apply to all interaction reports.  See
instructions for Changing Font Options on page 16.

Search a Report
Interaction Reports can be searched for words or text strings using
the Find command.

To search a report:

1. Use one of the following methods to open the Find dialog:

• Select Edit | Find on the menu bar.

• Click the Find button on the toolbar.
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• Right-click anywhere in the report and select Find.

2. The program displays the Find dialog.

3. Enter the desired word or text string in the “Find what” box and
click Find Next.

4. The cursor moves to the first occurrence of the entered word
or text string and highlights the selection.  Click Find Next to
find the next occurrence.

Print a Report
Interaction Reports in either the Report Window or Split Viewer
Window are printed using the typical Windows print dialog.  To
open this dialog use any of the following methods:

• Select File | Print on the menu bar.

• Click the printer icon on the toolbar.

• Right-click anywhere in the report window and select Print.

Save a Report
Reports can be saved as either a Text Only (.txt) or a Rich Text
Format (.rtf) file.  Text files can be opened by word processing
applications or Notepad but the font and formatting information will
be lost.  Rich Text Format files can be opened by Word and most
other word processing programs and the font and formatting
information will be preserved.

To save the report:

1. Select File | Save As on the menu bar.

2. On the Save As dialog type the desired File name.

3. On the Save As type drop-down menu select the file type (Text
Only or Rich Text Format).

4. Click Save.

Once a report has been saved use File | Save on the
menu bar or the Save button on the toolbar to resave
the file using the same file name.
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Managing Patients

Overview
A valuable feature of the program is that you can create and
maintain a directory of patients.  For each patient’s profile the
directory includes their name, an optional record ID (for example,
patient account number), and optional Patient’s Notes.  In addition,
you can save any list of drugs under the patient’s name.  In this
way it is quite simple to manage the drug list and print interaction
reports for that patient.

Add a Patient
New patients can be added to the program even if you do not
assign a list of drugs to the patient.

To add a patient:

1. Select Patient | New Patient on the menu bar or click the New
Patient button on the toolbar.

2. The program opens the New Patient panel for defining a
patient and for entering the pertinent related information.

3. Type the patient’s First and Last names, an optional Record ID
(for example; account number), and Notes that you want to
save with the patient file.  These notes will be printed in the
Interactions Report if you select the Include Patient Notes
check box.

4. Click OK when done.

Once a patient has been defined the information
can be changed.  See Edit Patient Info on page
32.

Delete a Patient
Once a patient is deleted it cannot be undone.  The patient profile
and associated drug list would need to be recreated.  The program
will ask if you are sure you want to delete the patient.  This gives
you the option to cancel if the selection is erroneous.

To delete a patient:

1. Select Patient | Delete Patient on the menu bar or click the
Delete Patient button on the toolbar.
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2. The program opens the Delete Patient panel to allow selection
of an existing patient from the list of defined patients in the
program.

3. Select a patient name from the list or type the patient’s last
name, then click Delete.

Find a Patient
The list of patients may get quite long.  This command assists you
in finding a patient by allowing you to search the patient list in lieu
of simply scrolling the alphabetized list.

To find a patient:

1. Select Patient | Find Patient on the menu bar.  The program
opens the Find Patient panel to allow selection of a patient.
You may either select the name from the alphabetized list or
type in the last name of the patient.

2. After selecting a name and clicking Open, the associated drug
list, if previously created, will be loaded into List of Drugs to
Check.  The patient’s name will be shown in the status bar and
you can edit or create a drug list for this patient.

Edit Patient Info
The Edit Patient Information command is used to change the
information you entered when the patient listing was created.

To edit patient information:

1. Select Patient | Edit Patient Info on the menu bar.  The
program opens the Edit Patient Info panel that allows you to
type in the last name or select by mouse one of the defined
patient profiles.

2. After making your selection, click the Edit button to open the
patient profile window.

3. You may change any of the information fields.  Click Save to
make the changes permanent or Cancel to close the patient
profile window without making changes.

Save a Patient (drug list)
This command allows you to save the drug list you have created
under a patient profile using a patient name.

To save the drug list to a patient:
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1. Select Patient | Save Patient on the menu bar.

2. If there is a patient name associated with the program the
name is displayed in the status bar, then the file is saved under
the current patient name. If there is not an associated patient
name (* shown in status bar).  A dialog asks you to create a
new patient profile or save the list to a currently defined
patient.

Save As Patient
This command saves the currently displayed drug list that was
opened from an existing patient profile or that you have created
without a patient profile to either an existing or a new patient.  See
Save Drug List to a Patient on page 26 for more information.

Compatibility With Earlier Versions
Windows 3.1 patient drug list files may be opened with the new
program.  However, once the file is saved in the new program, it
may no longer be used with the old program.

Importing old files

An importing tool is not included because it is not needed—old files
may be opened within the new program.

Opening an old PDL file

Select File | Open or click the open file button.  The open file dialog
opens.  Browse to your old folder containing your old .pdl files (the
default folder is /dipwin).  After selecting a file, the PDL (patient
drug list) will be loaded into the List of Drugs to Check.  You may
save this list as a new Adverse Drug Interactions Program style .pdl
file or save it using the Patient feature.

Saving an old PDL

You may save an old file as a new file. Select File | Save or File |
Save As. Caution: File | Save converts and overwrites your old 3.1
version file which cannot be used by the old program.  File | Save
As converts your old patient file to the new type and will be saved
in a Drug Lists folder in the new program; your old file will not be
overwritten and can still be used with the 3.1 program. Both
methods give the warning: "Okay to save your old style drug list in
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the new drug list format?" If you are saving the file to the new Drug
Lists folder the File | Save As dialog opens to the new folder by
default, then this is not an issue, but if you are writing over your
original file in the old folder (i.e. /dipwin) you may want to consider
whether you plan to use your Win3.1 version again.

Saving an old PDL file using the Patient feature

You can save this list under a patient's name using the Patient
feature by selecting Patient | Save As Patient.  A dialog box will
appear.  Click New to open the New Patient panel where you may
enter the patient's information.
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Keyboard Shortcuts

To… Press…

Activate the menu bar F10
Additional drug check (Add one drug) Ctrl+Alt+A
Add drug in text box to List of Drugs to Check Enter
Add highlighted drug to List of Drug to Check Shift+Enter
Carry out the corresponding command on the menu Alt+underlined letter in

menu
Click button (if active control is a button) Spacebar
Close the current window Ctrl+F4
Copy text Ctrl+C
Cut text Ctrl+X
Delete drug name from Main Window text box Delete
Delete highlighted drug from List of Drugs to Check Delete
Delete patient Ctrl+Alt+D
Edit patient information Ctrl+E
Exit program Alt+F4
Find patient Ctrl+Alt+F
Find text on report page Ctrl+F
Help F1
Move between various window controls Tab
New drug list Ctrl+N
New patient Ctrl+Alt+N
Open drug list Ctrl+O
Paste text Ctrl+V
Print report Ctrl+P
Redo text changes (in Report Window) Ctrl+R
Run interactions check (when text box is empty) Enter
Save drug list (in Main Window) Ctrl+S
Save interactions report (in Report Window) Ctrl+S
Save patient list Ctrl+T
Save current list as patient list Ctrl+Alt+T
Switch between Main Window and Report Window F12
Undo text changes (in Report Window) Ctrl+Z


	CONTENTS
	INTRODUCTION
	   About the Program
	        Keyboard Access
	        Patient Feature
	   Compatibility with earlier versions
	   Criteria for listing interactions
	INSTALLING THE PROGRAM
	   System Requirements
	   Installation
	   Start the Program
	   Exit the Program
	QUICK START
	   Create a Drug List
	   Viewing the Interactions Report
	   Viewing Interactions for One Drug
	   Viewing the Full Interactions Chart
	GETTING ACQUAINTED WITH THE PROGRAM
	   Program Windows
	       Main Window
	       Report Window
	       Split Viewer Window
	   Changing Program Options
	   Changing Font Options
	   Pulldown Menus
	       File Menu
	   Edit Menu
	       View Menu
	       Patient Menu
	       Help Menu
	   Toolbar Buttons
	       Main Window Toolbar Buttons
	       Report Window Toolbar Buttons
	MANAGING LISTS OF DRUGS TO CHECK
	   Overview
	   Create Drug Lists
	   Remove a Drug From the List
	   Save a Drug List
	       Save Drug List as a .pdl File
	       Save Drug List to a Patient
	MANAGING DRUG INTERACTION REPORTS
	   Overview
	   View Drug Interactions
	       Include Reference Citations
	       Include Patient Notes
	       View Interactions for One Drug
	   View Specialty Reports
	       Interactions chart
	       Food -- MAOI chart
	       P-450 Enzymes chart
	       Add One Drug to the Interactions Report
	   Edit a Report
	   Change the Report Appearance
	   Search a Report
	   Print a Report
	   Save a Report
	MANAGING PATIENTS
	   Overview
	   Add a Patient
	   Delete a Patient
	   Find a Patient
	   Edit Patient Info
	   Save a Patient (drug list)
	   Save As Patient
	COMPATIBILITY WITH EARLIER VERSIONS
	   Importing old files
	   Opening an old PDL file
	   Saving an old PDL
	   Saving an old PDL file using the Patient feature
	KEYBOARD SHORTCUTS

